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Caractéristiques
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Transfert de données haut débit USB 2.0

Son SRS WOW Surround
● La fonction Surround 3D (SRS) ajoute de l'espace au son.

Écran LCD TFT 18 pouces couleurs
● Vous obtenez ainsi des images et des vidéos de haute qualité.

Support de jeux divers
● Vous pouvez profiter de jeux comme Te tris, Omok et Othello.

Batterie rechargeable Li-Ion incorporée
● La batterie rechargeable au lithium intégrée permet d’écouter jusqu’à 25 heures de

musique et de visionner jusqu’à 5 heures 30 minutes de vidéo.
(selon les mesures de la société).

Fonction contrôle de la vitesse de lecture
● Vous pouvez régler la vitesse de lecture des fichiers musicaux ou vocaux. 

Possibilité de mise à jour
● Vous pouvez mettre à jour les programmes intégrés le cas échéant.

Veuillez vérifier la présence de mises à jour sur la page d'accueil du site
http://www.samsung.com.

Caractéristiques
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Support de stockage grande capacité
● Vous pouvez utiliser le disque dur intégré pour stocker toute votre discothèque.

Vous pouvez également l'utiliser comme disque dur externe pour votre PC et y
stocker d'autres fichiers de données.

Lecture de fichiers MP3, WMA, audio ASF et Ogg
● Votre lecteur peut lire les fichiers MP3, WMA, ASF Audio et Ogg.

Port d’accueil USB
● Vous pouvez librement transférer des données, comme de la musique ou des

images sans utiliser de PC, en raccordant directement des périphériques
numériques, comme un appareil photo numérique, un lecteur MP3, etc. au lecteur.

Fonction lecteur vidéo
● Vous pouvez visionner des fichiers vidéo après le téléchargement par le studio multimédia.

Fonction visionneuse de fichiers images et textes
● Vous pouvez visualiser les fichiers JPEG et TXT.

Enregistrement MP3 direct 
● Vous pouvez transformer de la musique d’un CD, une cassette ou la radio en

fichiers MP3.
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Avertissements de sécurité
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Suivez les consignes de sécurité relatives à la circulation
● N’utilisez pas les écouteurs en conduisant une voiture ou en circulant à vélo.

Cela est non seulement dangereux mais également interdit par la loi. 
● Vous risquez d’avoir un accident si le volume des écouteurs est trop élevé lorsque vous marchez

dans la rue.

Protégez vos oreilles
● Ne montez pas le volume trop haut.

Les médecins émettent des mises en garde contre l’exposition prolongée à des volumes excessifs. 
● Cessez d’utiliser l’appareil ou baissez le volume si vous ressentez des bourdonnements d’oreilles.

● L’utilisateur doit veiller à ce que le câble des écouteurs ne se coince pas dans son bras ou dans tout autre
objet pendant qu’il marche ou qu’il fait du sport.

● Conformez-vous aux directives locales concernant l’élimination des déchets lorsque vous vous
débarrassez d’emballages, de piles et d’appareils électroniques usagés. 

● L’emballage de votre lecteur est constitué de carton, de polyéthylène, etc., et ne comporte aucun
matériau inutile.

● Température ambiante: 5°C ~ 35°C (41°F ~ 95°F) 
● Humidité : 10% ~ 75%

I Écouteurs

I Conditions ambiantes d’utilisation 

I Informations relatives à l’environnement

Avertissements de sécurité

6

Merci de lire attentivement toutes les instructions afin d’éviter toute blessure ou dommage à l’appareil.

✽ Veuillez noter que nous déclinons toute responsabilité pour les dommages liés à la perte de données enregistrées
ou sauvegardées suite à une panne, une réparation ou à toute autre cause.

Ne laissez aucun corps
étranger pénétrer 
à l’intérieur de l’appareil.

N’exposez pas l’appareil
à des produits chimiques
tels que du benzène ou
des diluants.

N’appliquez pas de pression
excessive sur l’appareil.

Ne placez pas d’objets
lourds sur le dessus de
l’appareil.

Ne touchez jamais le
chargeur si vous avez les
mains mouillées.

N’exposez pas l’appareil
à la lumière directe du
soleil ou à des sources
de chaleur.

Ne placez pas l’appareil
dans un endroit comportant
beaucoup de poussière ou
de suie.

N'utilisez pas le lecteur près
d'un autre appareil susceptible
de générer un champ
magnétique important.

Ne tentez pas de
démonter ou de réparer
vous-même l’appareil.

N’exposez pas l’appareil à
des températures extrêmes
(supérieures à 35°C ou
inférieures à -5°C). Ne
placez pas l’appareil dans
un endroit humide.
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Précautions à prendre lors du chargement
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Un chargeur est fourni avec votre
lecteur.

Branchez le chargeur dans une prise
murale.
✻ Lorsque le chargement est terminé,

“Charge Completed” s'affiche sur l’écran.
✻ Pour recharger l’appareil via la connexion par

câble USB, sélectionnez [Settings] → [System]
→ [PC Connect Mode] → [Charge] dans le menu.
Pour procéder au rechargement via le câble USB,
le PC doit être sous tension. Si le PC passe en mode économie d’énergie, la batterie ne sera pas rechargée.

✻ Le temps de charge via le câble USB est d’environ 6 heures, tandis que le temps de charge via le chargeur
n’est que d’environ 4 heures.

AAAAtttt tttteeeennnntttt iiiioooonnnn
- Afin d'éviter tout risque d'incendie, ne laissez pas la batterie se recharger plus de 12 heures.
- Ne branchez pas plusieurs appareils sur la même prise murale.
- N'utilisez pas un chargeur défectueux.
- Lorsque vous utilisez une batterie rechargeable pour la première fois ou lorsque celle-ci 

n'a pas servi pendant plusieurs mois, commencez par la recharger complètement.
- Une surcharge risque de réduire la durée de vie de votre batterie.
- La batterie rechargeable est un consommable et sa capacité va diminuer progressivement.
- Afin de prolonger la durée de vie de votre batterie, utilisez la batterie entièrement rechargée

jusqu'à ce qu'elle soit entièrement déchargée puis rechargez-la de nouveau complètement
avant de la réutiliser.

- Veuillez noter que nous déclinons toute responsabilité pour les dommages liés à la perte de
données enregistrées ou sauvegardées suite à une panne, une réparation ou à toute autre cause.
Cela risquerait de provoquer un incendie ou un choc électrique.

- Ne touchez jamais le chargeur si vous avez les mains mouillées.

✍

Consignes de sécurité relatives au chargeur de batterie
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!

!ATTENTION
RISQUE DE CHOC ÉLECTRIQUE. NE PAS OUVRIR

Les pièces non isolées contenues dans le
chargeur peuvent provoquer un choc électrique. 
Pour votre sécurité, n'ouvrez pas le boîtier du
chargeur. 

Lisez ce Manuel de l'utilisateur afin de prévenir
tout problème pouvant survenir lors de l'utilisation
de ce chargeur.

AAAAvvvveeeerrrr tttt iiii sssssssseeeemmmmeeeennnntttt
- N'utilisez pas le chargeur à proximité d'une source d'eau afin d'éviter tout risque d'incendie

ou de choc électrique.

AAAAtttt tttteeeennnntttt iiiioooonnnn
- Afin d'éviter tout risque de choc électrique, n'utilisez le chargeur que sur une prise de courant

conforme aux indications données sur la fiche du transformateur.
- Assurez-vous que la fiche du chargeur est complètement insérée dans la prise murale.

✍

✍
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Emplacement des commandes
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Touche
Répétition en
boucle/Enregis
trement

INTERRUPTE
UR HOLD
(VERROU)

TOUCHE MENU

Affichage

Prise écouteurs

TOUCHE TOOL
(OUTILS)

[Arrière de
l’appareil]

TROU DE
RÉINITIALISATION

Touche d’alimentation
Touche lecture/pause

Bouton Skip/Search
(Saut/Recherche)

Touche
Sélection/Navigation/
Réglage du volume

Bouton Skip/Search
(Saut/Recherche)

Port de connexion par câble USB

Connecteur LINE IN
Microphone

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Réinitialisez le lecteur en enfonçant un objet pointu (un trombone, par exemple) dans le trou RESET.

✍

Accessoires
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● La capacité de la mémoire utile incorporée est inférieure à ce qui est spécifié puisque le
micrologiciel interne utilise également une partie de la mémoire.

● Les caractéristiques des accessoires sont susceptibles d'être modifiées sans préavis à des
fins d'amélioration.

Lecteur Écouteurs Câble d'entrée
audio

Guide de 
l’utilisateur

Chargeur

Câble USB

adaptateur USB CD d’installation Socle de 
synchronisation

Modèle

Mémoire intégrée

YH-J70 SB/SW

20Go

YH-J70 LB/LW

30Go

❊ Le socle de synchronization et boîtier portative sont foumis qu'avec le modèle d'une capacité de 30Go.

Boîtier portatif
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Affichage
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Indicateur Lecture/Pause

Indicateur de volume

Indicateur Durée
de lecture

Indicateur de mode Lecture
Indicateur EQ/SRS

Indicateur de batterie restante

Affichage du numéro de
la chanson

Titre de la piste en
cours de lecture

Indicateur de progression

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Les illustrations ne sont reproduites qu’à titre d’exemple. L’écran réel peut être différent.

✍

Emplacement des commandes
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Avant Arrière

Connecteur LINE OUTPort de connexion par câble USB

I Socle de synchronisation

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Vous pouvez écouter de la musique en insérant le lecteur dans son socle et en connectant des

écouteurs ou des haut-parleurs sur le connecteur de Connecteur LINE IN.
- Vous ne pouvez pas utiliser la fonction Hôte USB en utilisant le socle, même si vous connectez

l’adaptateur hôte USB.

✍

❊ Le socle de synchronization et boîtier portative sont
foumis qu'avec le modèle d'une capacité de 30Go.
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Connexion à l'ordinateur
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2 Suivez les instructions à l’écran pour terminer l’installation.

Connexion à l'ordinateur

14

Installez Samsung Media Studio avant de connecter le
lecteur au PC.

❑ Configuration système
nécessaire

Le PC doit avoir au minimum la
configuration suivante:

● Pentium 200MHz ou plus
● Windows XP
● 50 Mo d’espace disque

disponible
● Lecteur de CD-ROM.(double

vitesse au minimum)
● Prise en charge du port

USB (2.0)
● Version DirectX 9.0 ou

supérieure

RReemmaarrqquuee
- Connectez-vous à votre PC en tant

qu'administrateur (Utilisateur princi-
pal) et installez les logiciels fournis
(Media / Multimedia Studio) pour
Windows XP. 
Vous pouvez modifier les informa-
tions du compte en sélectionnant
[Start] → [Control Panel] →
[User Account] à partir de la barre
des tâches de votre PC.

I Installation du logiciel

1 Insérez le CD d’installation dans le lecteur de

CD-ROM.
L’image indiquée ci-dessous apparaît.
Sélectionnez [Install Samsung Media Studio].

✍
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Connexion à l'ordinateur
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Comment vérifier si le pilote USB est installé correctement?
Windows XP: 

Control Panel → System → Hardware → Device Manager → Disk Drives →
Samsung YH-J70 USB Device

5 Si le pilote USB ne s’installe pas automatiquement, reportez-vous à la page
suivante.

Connexion à l'ordinateur
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1 Connectez le câble USB au port USB de l’ordinateur.

2 Connectez l’autre extrémité du câble USB au port de connexion USB situé au bas
du lecteur.
● Si vous débranchez le câble USB de votre PC lors de l'exécution d'une instruction ou si vous

effectuez une initialisation pendant l'installation du pilote USB, votre PC risque de ne pas 
fonctionner correctement.

4 Lors de l’installation du pilote USB, "SAMSUNG YH-J70 USB Device" apparaît
dans le [Device Manager].

3 Si le pilote USB est installé, un message apparaît indiquant la recherche d’un 
nouveau périphérique. Il est possible que l'écran d'affichage ne puisse être 
visualisé au cours de l'installation. Sélectionnez le gestionnaire de périphériques
pour vérifier que l'installation s’est terminée avec succès.

I Connexion du lecteur à un PC au moyen d'un câble USB

PC PC

Câble USB Câble USB

Lecteur

Lecteur

Socle de
synchronisation

RReemmaarrqquuee
- Pour une utilisation par connexion au socle de chargement, connectez le câble USB au port de

connexion USB du socle.

✍
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Utiliser le lecteur comme disque amovible
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I Débranchement du câble USB
Une fois le transfert de fichiers terminé, débrancher le câble de la manière suivante :

1 Faites un double clic sur la flèche verte
dans la barre des tâches située en bas à
droite de votre écran.

2 Sélectionnez le périphérique USB et cliquez le bouton [STOP]. 
Lorsque l’écran [Stop a Hardware Device] apparaît, cliquez sur le
bouton [OK] et ensuite déconnectez le câble USB.

AAtt tteenntt iioonn
- Si vous déconnectez le câble USB de manière incorrecte, les fichiers sur le périphérique 

peuvent être endommagés et ne plus se lire.

✍

Utiliser le lecteur comme disque amovible
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Vous devez choisir le mode de connexion PC avant d’utiliser le lecteur comme disque amovible.
Appuyez sur le bouton MENU et sélectionnez [Settings] → [PC Connect Mode] →
[Removable Disk] à partir du menu.

I Télécharger des fichiers
1 Connectez le lecteur à votre PC.
2 Faites un double clic sur le bouton Démarrer, ensuite sélectionnez explorer pour

ouvrir l’explorateur Windows.
● Un disque amovible s’affiche dans l’explorateur Windows.

3 Choisissez les fichiers à sauvegarder et faites-les glisser vers le dossier souhaité.
● Faites glisser des fichiers musicaux vers le dossier MUSIC, des fichiers textes vers le

dossier TEXT, des fichiers images vers le dossier PHOTO, des fichiers svi vers le dossier
VIDEO et des fichiers de données vers le dossier DATA.
- Le dossier DATA ne s’affiche pas sur le lecteur.

● Le lecteur ne supporte que les fichiers vidéo en extension .svi.Pour visualiser des fichiers vidéo
d’autres formats, convertissez les fichiers avec le Studio Multimédia et transférez ensuite les
fichiers dans le lecteur.

AAtt tteenntt iioonn
- La déconnexion du câble USB alors que des fichiers sont en cours de téléchargement ou de

chargement risque d'entraîner un dysfonctionnement du lecteur.
- L'ordre dans lequel les fichiers musicaux sont affichés dans l'Explorateur Windows peut être

différent de l'ordre dans lequel les fichiers sont lus sur votre lecteur.

✍
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Utilisation de Media Studio
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3 Quand les fichiers musicaux apparaissent, sélectionnez le(s) fichier(s) que vous
souhaitez transférer et pressez le bouton [Transfer] .

●  Les fichiers sélectionnés sont transférés sur le lecteur.
●  Sélectionnez [Device] → [Reconstruct Library] à partir de Media Studio si le(s)

fichier(s) est (sont) téléchargé(s) à partir d’un disque amovible.
Les fichiers musicaux sont automatiquement classés dans les dossiers artiste,
album, genre, et piste en fonction des infos balise. Les dossiers artiste, album,
genre et piste peuvent être retrouvés en passant par le menu [Settings] →
[Navigation] → [Music Library].

RReemmaarrqquuee
- Reportez-vous à l’Aide pour de plus amples informations.
- Qu'est-ce qu'une balise ID3?

Il s'agit d'une balise jointe à un fichier MP3 qui contient les informations pertinentes relatives au
fichier : titre, artiste, album, année, genre et un champ commentaires.

✍

Utilisation de Media Studio
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● Media Studio est le programme qui vous permet de télécharger des fichiers musicaux vers le
lecteur et de lire des fichiers musicaux sur votre PC.

● Cliquez sur l’icône Media Studio sur le bureau.

Fenêtre
[Librairie]

Fenêtre de
connexion d’un
périphérique

I Télécharger des fichiers.

1 Connectez le lecteur à l’ordinateur.
● Une fenêtre de connexion d’un périphérique apparaîtra sur la droite de votre écran.

Si la fenêtre de Connexion du lecteur ne s’affiche pas automatiquement,
sélectionnez [Device] → [Show device Window] à partir du menu du haut.

2 Sélectionnez le dossier contenant les fichiers que vous souhaitez transférer dans
la fenêtre [Librairie].
● Les fichiers musicaux dans le dossier apparaissent au centre de l’écran.
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Utilisation de Media Studio
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RReemmaarrqquuee

- Une nouvelle liste de lecture est créée quand le bouton [ADD] dans la fenêtre de liste de
lecture est cliqué.
Une liste de lecture sélectionnée est supprimée quand le bouton [delete] est cliqué.

- Reportez-vous à l'Aide de plus amples de plus amples informations.

4 Faites glisser les fichiers souhaités
dans la liste de lecture créée.

5 Pressez le bouton [Transmit] dans la
fenêtre de la liste de lecture après avoir
sélectionné la liste de lecture.
● Les fichiers dans la liste de lecture

sont transférés au lecteur.
● Déconnectez le lecteur du PC et

appuyez sur la touche MENU du
lecteur. Puis sélectionnez
[Navigation] → [Playlist] → [PC Playlist]
pour visualiser la liste de lecture
transférée.

✍

Utilisation de Media Studio
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I Envoi d’une liste de lecture

1 Connectez le lecteur à l’ordinateur.

2 Cliquez sur [File] → [Add Playlist] en haut de l’écran.
● Entrez le nom de la liste de lecture lorsque l'écran apparaît.

3 Sélectionnez le dossier avec le(s) fichier(s) que vous souhaitez transférer
depuis la fenêtre librairie.
● Les fichiers musicaux dans le dossier apparaissent au centre de l'écran.
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Utilisation de Media Studio
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1 Insérez votre CD contenant les pistes à extraire dans le lecteur de CD-ROM
de votre ordinateur.

2 Cliquez sur le bouton [Search Audio CD] dans la partie inférieure de l’écran.
● Les pistes du CD s'affichent.

3 Sélectionnez les pistes à extraire et cliquez sur [Rip a CD] . 
● Les fichiers sélectionnés sont convertis en fichiers MP3.
● Sélectionnez [Tools] → [Audio Source Format Conversion Settings] en haut de

l’écran pour changer les paramètres d’extaction.

I Extraire des fichiers d’un CD audio

RReemmaarrqquuee
- Reportez-vous à l'Aide de plus amples de plus amples informations.

Changement
de format.

Chemin de
sauvegarde

✍

Utilisation de Media Studio
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1 Connectez le lecteur à l’ordinateur.

2 Cliquez sur [Device] → [Format] en haut de l’écran

3 Cliquez le bouton [Start] quand l’écran Format apparaît.
● La mémoire du lecteur est formatée et tous les fichiers enregistrés seront

supprimés.

I Formater le lecteur

RReemmaarrqquuee
- Reportez-vous à l'Aide de plus amples de plus amples informations.
- Si vous avez formaté le lecteur sur votre PC, veuillez le reformater à l’aide de Media Studio.

✍

● Le formatage supprime tous les fichiers sur le lecteur MP3 offrant une capacité de mémoire
maximum pour le stockage de nouveaux fichiers.
Cela vous évite de supprimer les fichiers indésirables un à la fois.
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Utilisation de Media Studio
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1 Connectez le lecteur à l’ordinateur.

2 Cliquez sur le bouton [Delete] en bas de l’écran de connexion après avoir 
sélectionné les fichiers ou dossiers dans la fenêtre de connexion d’un périphérique.
● Le fichier ou dossier sélectionné est supprimé.

I Suppresion d’un dossier/fichier

RReemmaarrqquuee
- Reportez-vous à l'Aide de plus amples de plus amples informations.

✍

Utilisation de Media Studio
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1 Connectez le lecteur à l’ordinateur.

2 Cliquez sur le bouton [Create Folder] en bas de la fenêtre de connexion d’un
périphérique.

3 Entrez le nom du nouveau dossier quand un écran apparaît.
● Un nouveau dossier est créé.
● Si vous ouvrez un nouveau dossier et transférez un fichier, le fichier est

transféré dans le dossier nouvellement créé.

I Créer un dossier

RReemmaarrqquuee
- Reportez-vous à l'Aide de plus amples de plus amples informations.

✍
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Installation de Multimedia Studio
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● Multimedia Studio est un programme qui prend en charge la modification d'images, la lecture
de séquences vidéo et la conversion de format, ainsi que la création d'albums multimédia.

I Installation du logiciel
1 Insérez le CD d’installation dans le lecteur de CD-ROM. 

Sélectionnez [Install Multimedia Studio].

2 Sélectionnez la langue.

Suite...

Utilisation de Media Studio
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I Accéder à l’aide de Media Studio
Appuyez sur F1 après avoir démarré Media Studio.
● La fenêtre Help (Aide) apparaît.

Cliquez sur [Help] en haut de l’écran.
● Cliquez sur Aide et la fenêtre Aide apparaît.

RReemmaarrqquuee
- La technologie de reconnaissance de musique et des données associées sont fournies par

Gracenote et Gracenote CDDB® Music RecognitioSM. 
- CDDB est une marque déposée appartenant à Gracenote. Le logo et logotype Gracenote, le

logo et logotype Gracenote CDDB, ainsi que le logo "Powered by Gracenote CDDB" sont des
marques appartenant à Gracenote. Music Recognition Service et MRS sont des marques de
service de Gracenote.

✍
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Utilisation de Multimedia Studio
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● Lancez Multimedia Studio à partir du Bureau.

I Modification d'images
1 Sélectionnez le dossier contenant les images

à modifier à partir de la fenêtre du répertoire
située dans la section supérieure gauche de
Multimedia Studio.
● Les fichiers enregistrés s'affichent dans la fenêtre

Liste de fichiers située à droite.

2 Sélectionnez l'image à modifier.
● L'image sélectionnée s'affiche dans la fenêtre

[Preview image].

3 Appuyez sur le bouton [Edit Img].
● À partir de la fenêtre [Picture editor], vous pouvez accéder à des fonctions telles que

l'édition de papiers peints, l'édition de couches, l'insertion de clip-arts, la création de
cadres ainsi que d'autres fonctions d'édition.

RReemmaarrqquuee
- Consultez l'Aide pour plus d'informations.

✍

Installation de Multimedia Studio

30

3 Suivez les instructions à l’écran pour terminer l’installation. 
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Utilisation de Multimedia Studio
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6 Réglez la taille et déterminez le chemin de l'image dans la fenêtre
[Resize images], puis cliquez sur le bouton [OK].
● L'image est envoyée vers le périphérique sélectionné.

● Les photos transférées peuvent être visionnées avec [photo/video] → [photo].

● La taille optimale pour afficher l'image sur l'appareil est 160 x 128.
Veuillez ajuster la taille de l'image si cette dernière ne s'affiche pas correctement sur le
lecteur.

RReemmaarrqquuee
- Le chemin fait référence à l'emplacement ou au dossier où les images converties sont

enregistrées sur votre PC.
- Les fichiers images enregistrés sur le lecteur peuvent être supprimés en sélectionnant

[File] → [Delete images from device].

- Consultez l'Aide pour plus d'informations.

✍

Utilisation de Multimedia Studio
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I Envoi des images
1 Connectez le lecteur à votre PC.

2 Sélectionnez les images à envoyer vers le lecteur.

3 Sélectionnez [File] → [Export images to device] en haut du menu Multimedia Studio.

4 Sélectionnez le périphérique connecté au PC à partir de l'écran [Select device],
puis appuyez sur le bouton [OK].

5 Sélectionnez le dossier à enregistrer à partir de la fenêtre de sélection du dossier,
puis cliquez sur le bouton [OK].

Sélectionnez le mode de connexion au PC avant de transférer des fichiers images
ou des fichiers vidéo au moyen de Multimedia Studio. Appuyez sur le bouton MENU
et sélectionnez [Settings] → [PC Connect Mode] → [Removable Disk] dans le menu.
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Utilisation de Multimedia Studio
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5 Sélectionnez le dossier à sauvegarder dans l’écran de sélection et cliquez
ensuite sur OK.

6 Cliquez sur le bouton [Convert] lorsque l’écran de conversion apparaît.
● Le fichier converti est transmis en format .svi.
● Le fichier vidéo transféré peut être visionné à partir du menu [Photo/Video] → [Video].

▲ Pour convertir et tranférer un fichier vidéo, il faut:
1. vérifier que Direct X 9.0 ou une version supérieure est installé sur votre ordinateur.
2. vérifier que Windows Media Player 9.0 ou une version supérieure est installé sur votre

ordinateur.
3. vérifier si Unified Code Pack est installé sur votre ordinateur.

RReemmaarrqquuee
- Les fichiers vidéo enregistrés sur le lecteur peuvent être supprimées en sélectionnant [File] →

[Delete videos from device].
- Reportez-vous à l'Aide de plus amples de plus amples informations.

✍

Utilisation de Multimedia Studio
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I Envoyer des vidéos

1 Connectez le lecteur à l’ordinateur.

2 Sélectionnez la(les) vidéo(s) à envoyer sur le lecteur.

3 Sélectionnez [File] → [Export videos to device] en haut de Mutlimedia Studio.

4 Sélectionnez le périphérique connecté à l’ordinateur depuis l’écran
[Select device] et ensuite cliquez sur [OK].

Sélectionnez le mode de connexion au PC avant de transférer des fichiers images
ou des fichiers vidéo au moyen de Multimedia Studio. Appuyez sur le bouton MENU
et sélectionnez [Settings] → [PC Connect Mode] → [Removable Disk] dans le menu.
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Utilisation de Multimedia Studio
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3 Appuyez sur le bouton     [Capture] puis appuyez
sur le bouton     [Capture] lorsque l'image que vous
souhaitez capturer apparaît.
● Les images sélectionnées sont capturées.

4 Appuyez sur le bouton [Save].
● Enregistrer cette image capturée : permet d'enregistrer

l'image actuellement sélectionnée.
● Enregistrer toutes les images capturées : permet

d'enregistrer toutes les images capturées.

1

2

2

1

Suite...

Utilisation de Multimedia Studio
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I Capture vidéo

1 Appuyez sur le bouton [Capture] situé en
haut du menu de Multimedia Studio.
● L'écran Media Player s'affiche.

2 Cliquez sur [Menu] → [Open] sur votre PC et sélectionnez la vidéo que vous
souhaitez lire.
● La lecture de la vidéo sélectionnée commence.
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Utilisation de Multimedia Studio

I Affichage de l'Aide de Multimedia Studio
Lancez Multimedia Studio et appuyez sur le bouton Aide situé en haut de l'écran.

● L'Aide s’affiche.

Utilisation de Multimedia Studio
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5 Sélectionnez le dossier dans lequel les images doivent être enregistrées à l'aide
de la fenêtre [Save As], puis appuyez sur le bouton [Save].
● L'image sélectionnée est enregistrée.

RReemmaarrqquuee
- Les codecs de lecture vidéo et de conversion ne sont pas fournis. Nous vous recommandons

d'utiliser les toutes dernières versions des codecs.
- Consultez l'Aide pour de plus amples informations.

✍
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Fonction Verrou 
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I Point de départ
Pendant la lecture d’un fichier musical, appuyez sur 
la touche A↔B au début de la boucle que vous 
souhaitez définir.
● A↔ apparaît sur l'écran d'affichage.

Appuyez brièvement sur la touche A↔B à l’endroit où
vous souhaitez mettre fin à la répétition en boucle.
● A↔B apparaît sur l’écrand’affichage. 
● La boucle est lue à plusieurs reprises.  

Appuyez sur la touche A↔B brièvement pour annuler
la répétition en boucle.

I Point d’arrivée

Répétition en boucle

Utilisez le fonction Verrou (Hold) pour verrouiller tous les boutons et les rendre inactifs.

Fonction Verrou (Hold) de l’appareil

Activez la touche de l’appareil.

❈ Tous les boutons de l’appareil sont rendus inactifs, et seuls les boutons de la télécommande
peuvent être utilisés.

❈ Lorsque vous activez le commutateur HOLD, un " " apparaît à l’écran.

Écouter de la musique

40

I Lecture de musique

I Pause de la musique

● Mise sous tension : Maintenez la touche √» enfoncé pour mettre le lecteur sous tension.
● Mise hors tension : Maintenez la touche √» enfoncé pour mettre l'appareil hors tension.

Maintenez la touche √» enfoncée.
● La lecture commence automatiquement.

Appuyez sur la touche √» pour mettre la lecture sur
pause. 
● En mode Pause, réappuyez brièvement sur la touche √»

pour reprendre la lecture.

Assurez-vous que le lecteur est entièrement chargé et que les écouteurs sont branchés.

Réglez le volume en déplaçant la touche SELECT vers le haut ou vers le bas.
● Le volume peut être réglé progressivement entre 00(MIN) et 60(MAX).

I Réglage du volume
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Fonctions principales en mode musical
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● Vous pouvez effectuer une sélection à l’aide de la touche SELECT.
● Appuyez sur la touche pour passer à l’écran précédent.

1 Appuyez sur la touche TOOL en mode musique.
● L’écran Music Tool apparaît.

2 Appuyez sur la touche SELECT après avoir ouvert
le menu [Add to Favorites].

3 Appuyez sur la touche SELECT après avoir atteint
la liste à enregistrer.
● Le fichier sélectionné est transféré vers la liste.
● 10 listes de lecture peuvent être sélectionnées.
● Les fichiers ajoutés sont accessibles à partir du menu

[Navigation] → [Playlist] → [Favorites].

1 Appuyez sur la touche TOOL en mode musique.
● L’écran Music Tool apparaît.

2 Appuyez sur la touche SELECT après avoir ouvert
le menu [EQ].

3 Appuyez sur la touche SELECT après avoir atteint
le mode d’effet sonore désiré.
● Normal → Jazz → Classic → Pop → Rock → Bass Boost → Bass Cut → R&B → Club →

Dance → House → High Boost → High Cut Loud → Ballad → Strings → Vintage →
Vocal Boost → Bluesy → User EQ

● Lorsque vous utilisez le mode User EQ, l’effet sonore désiré peut être réglé à partir du
menu [Settings] → [Sound Effect] → [User EQ Set].

I EQ

I Add to Favorites

Add to Favorites

TOOL

EQ

SRS

Play Mode

File Info.

Add to Favorites

TOOL

EQ

SRS

Play Mode

File Info.

List 2

List 3

List 4

List 5

List 1

Jazz

Classic

Pop

Rock

Normal

Recherche de fichiers musicaux/vocaux
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RReemmaarrqquuee
- Fichier VBR (variable bit rate): un fichier qui change constamment de taux de compression

selon le type de son, par exemple leur ton, dans le fichier.
- Avec un fichier VBR, il peut être impossible d’atteindre et de lire la piste précédente même si la

touche est enfoncée dans les cinq secondes qui suivent le début de la lecture.
- Les fichiers téléchargés en MP2 ou MP1 dont l’extension a été changée en MP3 peuvent ne

pas être lus.

● Gardez la touche , enfoncée durant la lecture pour rechercher la section que vous
souhaitez écouter.

● Relâchez la touche pour reprendre la lecture normale.

I Recherche d’une section particulière durant la lecture.

● Pressez la touche brièvement durant la lecture pour avancer à la piste suivante.
● Pressez la touche brièvement dans les 5 secondes du démarrage de la lecture pour

reculer à la piste précédente. Pressez la touche brièvement après 5 secondes pour
redémarrer cette piste du début.

I Recherche d’un fichier spécifique durant la lecture.

● Pressez la touche , en mode arrêt/pause pour passer à la piste précédente/suivante.

I Changement de piste lorsque le lecteur est arrêté

✍
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1 Appuyez sur la touche TOOL en mode musique.
● L’écran Music Tool apparaît.

2 Appuyez sur la touche SELECT après avoir ouvert
le menu [Play Mode].

3 Appuyez sur la touche SELECT après avoir atteint
le mode Play désiré.
● Normal : permet de lire une fois tous les fichiers dans l’ordre.
● Repeat: Appuyez sur la touche SELECT après avoir placé le curseur sur [Repeat].

- One : permet de répéter un fichier.
- Folder : permet de répéter le dossier en cours de lecture.
- All : permet de répéter la lecture de tous les fichiers.

● Shuffle (Aléatoire) : appuyez sur la touche SELECT après avoir placé le curseur sur [Shuffle].
- Folder : permet de lire les fichiers du dossier dans un ordre aléatoire.
- All : permet de lire les fichiers dans un ordre aléatoire.

I Play Mode

1 Appuyez sur la touche TOOL lorsque le
fichier musical est en cours de lecture
ou arrêté.
● L’écran Music Tool apparaît.

2 Appuyez sur la touche SELECT après
avoir placé le curseur sur [File Info].
● Les informations sur le fichier en cours de

lecture/en pause s’affichent.

I File Info.

Blue Durée

Artiste

Album

Genres

Taille de fichier

Sky

Best

Dance

7782656 bytes

Add to Favorites

TOOL

EQ

SRS

Play Mode

File Info.

Repeat

Shuffle

Normal

Fonctions principales en mode musical
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1 Appuyez sur la touche TOOL en mode musique.
● L’écran Music Tool apparaît.

2 Appuyez sur la touche SELECT après avoir
ouvert le menu [SRS].

3 Appuyez sur la touche SELECT après avoir
atteint le mode SRS désiré.
● Normal → SRS → TruBass →  WOW →  HD
● SRS : le lecteur bascule en son stéréo 3D.
● TruBass : fonction d'amplification des basses qui ajoute de l'amplitude au son.
● WOW : fonctionnalité permettant de bénéficier simultanément des effets SRS et Trubass.
● HD : Vous povez profiter d’une voix plus claire et de tons plus élevés.

Add to Favorites

TOOL

EQ

SRS

Play Mode

File Info.

SRS

TruBass

WOW

HD

Normal

I SRS

RRRReeeemmmmaaaarrrrqqqquuuueeee
- est une marque de SRS Labs, Inc. 

WOW technologie est incorporé sous licence de SRS Labs, Inc.
- Réglez le volume à un niveau adéquat, car il se peut qu'il augmente sous l'effet de la fonction SRS.
- Cet appareil prend en charge les fréquences d'échantillonnage suivantes

: 32 KHz, 44,1 KHz et 48 KHz.

✍
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Ecouter la radio FM
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Appuyez sur la touche MENU.
Dans le Menu, sélectionnez FM Radio et appuyez sur la touche SELECT.

I Changer en mode radio FM

● Recherche manuelle: Pressez les touches , pour changer la fréquence.

● Recherche automatique: Gardez les touches , appuyées pour rechercher
automatiquement des fréquences.

I Recherche de fréquence

Options du MENU
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01 I Music 02 I FM Radio 03 I Navigation 04 I Text

05 I Photo/Video 06 I USB Host 07 I Games 08 I Settings

● Now playing : Affiche la chanson en train d’être lue.
● FM Radio : Pour écouter la radio FM.
● Navigation : permet d’accéder au mode Navigation et de parcourir les fichiers et les dossiers.
● Text  : Pour lire des fichiers texte.
● Photo/Video : permet de visionner des fichiers image ou des vidéos.
● USB Host : Permet de transférer les fichiers enregistrés sur l’appareil vers des

périphériques externes ou de transférer des fichiers enregistrés sur des
périphériques externes vers le lecteur.

● Games : permet de jouer.
● Settings : permet de régler les fonctions.

Appuyez sur la touche MENU pour passer en mode MENU.
Utilisez la touche SELECT pour sélectionner l'élément du menu que vous désirez, puis appuyer
brièvement sur la touche SELECT.

RReemmaarrqquuee

- En mode Menu, appuyez sur la touche pour passer à l’écran précédent.

✍
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Réglage des principales fonctions du mode FM
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● Vous pouvez régler manuellement les fréquences FM désirées.
● Vous pouvez mémoriser jusqu’à 30 fréquences.

1 Appuyez sur la touche TOOL en mode FM.
● L’écran FM Tool apparaît.

2 Appuyez sur la touche SELECT après avoir placé le
curseur sur [Edit Preset].

3 Appuyez sur la touche SELECT après avoir placé le
curseur sur [Save] ou [Delete].
● Save : sélectionnez le numéro de présélection désiré

à l'aide de la touche SELECT. La fréquence actuelle est
enregistrée.

● Delete : sélectionnez un numéro de présélection à supprimer.
La fréquence mémorisée correspondant au numéro PRESET sera supprimée.

I Edit Preset

1 Appuyez sur la touche TOOL en mode FM.
● L’écran FM Tool apparaît.

2 Appuyez sur la touche SELECT après avoir placé le
curseur sur [Auto Preset].
● Jusqu’à 30 fréquences peuvent être automatiquement

enregistrées.

I Auto Preset

Mono/Stereo

TOOL

Preset Mode

Edit Preset

Auto Preset
Delete

Save

Mono/Stereo

TOOL

Preset Mode

Edit Preset

Auto Preset

Preset Memory

CH 01: 87.75

CH 02: 91.90

CH 03: 95.90

CH 04: 103.50

CH 05: 107.70

Réglage des principales fonctions du mode FM
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1 Appuyez sur la touche TOOL en mode FM.
● L’écran FM Tool apparaît.

2 Appuyez sur la touche SELECT après avoir placé
le curseur sur [Mono/Stereo].

3 Appuyez sur la touche SELECT après avoir placé
le curseur sur le mode de réception FM désiré.

Mono/Stereo

TOOL

Preset Mode

Edit Preset

Auto Preset

Stereo

Mono

I Mono / Stereo

● Vous pouvez effectuer une sélection à l’aide de la touche SELECT.
● Appuyez sur la touche pour passer à l’écran précédent.

RReemmaarrqquuee
- Mono est automatiquement sélectionné dans les régions où

la réception FM est de mauvaise qualité.

1 Appuyez sur la touche TOOL en mode FM.
● L’écran FM Tool apparaît.

2 Appuyez sur la touche SELECT après avoir placé
le curseur sur [Preset Mode].

3 Appuyez sur la touche SELECT après avoir placé
le curseur sur On/Off.
● On : le mode Preset est sélectionné. Sélectionnez la

fréquence présélectionnée à l’aide de la touche
, .

● Off : permet de sélectionner le mode de réception FM.

I Preset Mode
Mono/Stereo

TOOL

Preset Mode

Edit Preset

Auto Preset
Off

On

✍
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Enregistrement de la radio FM

1 Maintenez la touche REC enfoncée pendant la réception de la radio FM. 
● L’écran Recording apparaît.

2 Appuyez sur la touche REC.
● L’émission FM en cours de diffusion est enregistrée.

3 Appuyez à nouveau sur la touche REC.
● L’enregistrement s’arrête et le fichier est créé.
● Les fichiers sont enregistrés et renommés F001.mp3, F002.mp3, etc.
● Les fichiers MP3 sont enregistrés dans le dossier [Navigation] → [File Search] →

[RECORDED] → [FM]. Un dossier d’enregistrement peut contenir jusqu’à 999 fichiers.
● Appuyez sur la touche √» pour lire le fichier enregistré.

-REC:Start -TOOL:Exit F001.mp3

108.00 MHz 108.00 MHz

Dictaphone
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-REC:Start -TOOL:Exit

1 Maintenez la touche REC enfoncée.
● L’écran Recording apparaît.

2 Appuyez sur la touche REC pour commencer l'enregistrement vocal.

3 Appuyez à nouveau sur la touche REC.
● L’enregistrement s’arrête et le fichier est créé.
● Les fichiers sont enregistrés et renommés V001.mp3, V002.mp3, etc.
● Le fichier MP3 ainsi créé est enregistré dans le dossier [Navigation] → [File Search] →

[RECORDED] → [VOICE]. Un dossier d’enregistrement peut contenir jusqu’à 999 fichiers.
● Appuyez sur la touche √» pour lire le fichier enregistré.

RReemmaarrqquuee
- Même en augmentant le réglage du taux d’échantillonnage et du débit binaire, l’enregistrement

vocal sera par défaut à 44.1kHz.

✍

V001.mp3
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Réglage des principales fonctions du mode Navigation
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File Search
Music Library
Playlist

Navigation

MUSIC
PHOTO
RECORDED
TEXT
VIDEO
POP

File Search

Sexy boms.mp3
blue.mp3
Ill be there for you.mp3
San eye.mp3
Only for you.mp3
Happy.mp3

MUSIC

1 Maintenez la touche SELECT enfoncée pour passer en mode Navigation ou appuyez
sur la touche MENU pour atteindre le Menu, puis sélectionnez Navigation.
● File Search : vous permet de recherche un fichier dans les dossiers MUSIC, PHOTO,

TEXT ou VIDEO.
● Music Library : permet de rechercher un fichier musical par artiste, par album, par genre

et par piste.
● Playlist : vous permet de recherche un fichier donné enregistré comme Favoris sur le

lecteur ou sur une liste de lecture du PC transférée à l'aide de Media Studio.

2 Sélectionnez le fichier ou le dossier dont vous souhaitez commencer la lecture.
● : permet de revenir au dossier du niveau supérieur.
● : permet de revenir au dossier du niveau inférieur.
● ▲ ,▼ : permet de se déplacer vers un autre fichier ou dossier au sein d'un même répertoire.
● SELECT : permet de passer au dossier situé immédiatement en dessous.

3 Appuyez sur la touche SELECT.
● Le fichier sélectionné est lu.

● Vous pouvez effectuer une sélection à l’aide de la touche SELECT.
● Appuyez sur la touche pour passer à l’écran précédent.

Enregistrer des fichiers MP3
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1 Raccordez le port de sortie de la
source audio externe (ou le port de
sortie de ligne) au port ENTREE DE
LIGNE de l'appareil à l'aide du câble
d'entrée de ligne.
● Appuyez sur le bouton de lecture de

l'appareil externe pour lire la musique
à enregistrer.

2 Maintenez la touche REC enfoncée.
● L’écran Recording apparaît.

3 Appuyez sur la touche REC.
● L’enregistrement commence.

4 Appuyez à nouveau sur la touche REC.
● L’enregistrement s’arrête et le fichier est créé.
● Les fichiers sont enregistrés et renommés L001.mp3, L002.mp3, etc.
● Les fichiers MP3 sont enregistrés dans le dossier [Navigation] → [File Search] →

[RECORDED] → [LINE]. Un dossier d’enregistrement peut contenir jusqu’à 999 fichiers.
● Appuyez sur la touche √» pour lire le fichier enregistré.

AAtt tteenntt iioonn
- Ne débranchez pas le câble de ligne pendant l'enregistrement.
- Si la batterie n’est pas suffisamment chargée, le fichier ne pourra pas être entièrement codé

par le lecteur.
- Réglez le volume de la source audio externe à un niveau adéquat avant de lancer l'enregistrement.

Si le volume est trop élevé, la qualité sonore peut être mauvaise.

-REC:Start -TOOL:Exit L001.mp3

✍
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Réglage des principales fonctions du mode Navigation
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1 Appuyez sur la touche TOOL après avoir placé le
curseur sur le fichier musical en mode Navigation.
● L’écran Navigation Tool apparaît.

2 Appuyez sur la touche SELECT après avoir ouvert
le menu [Add to Favorites].

3 Appuyez sur la touche SELECT après avoir atteint la liste à enregistrer.
● Le fichier sélectionné est ajouté à la liste.
● 10 listes de lecture peuvent être sélectionnées.
● Les fichiers ajoutés sont accessibles à partir du menu [Navigation] → [Playlist] → [Favorites].

I Add to Favorites

●  Les fichiers enregistrés peuvent être supprimés en
mode Navigation. Les autres fichiers peuvent être
supprimés à l’aide de Media Studio.

1 PAppuyez sur la touche TOOL après avoir placé le
curseur sur le fichier enregistré à supprimer en
mode Navigation.
● L’écran Navigation Tool apparaît.

2 Appuyez sur la touche SELECT après avoir placé le
curseur sur [Delete File]. 
● Le fichier sélectionné est supprimé.

I Delete File
V001.MP3
V002.MP3
V003.MP3

VOICE001

Go to Top
Add to

TOOL

List 1
List 2
List 3
List 4
List 5

Go to Top
Delete File

TOOL

Réglage des principales fonctions du mode Navigation
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Go to Top
Add to Favorites

TOOL

1 Appuyez sur la touche TOOL en mode Navigation.
● L’écran Navigation Tool apparaît.

2 Appuyez sur la touche SELECT après avoir placé le curseur sur [Go to Top].
● Entrez dans la fenêtre File Navigation.

I Go to Top

● Vous pouvez effectuer une sélection à l’aide de la touche SELECT.
● Appuyez sur la touche pour passer à l’écran précédent.

File Search
Music Library
Playlist

Navigation
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Réglage des principales fonctions du mode Texte
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Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

Add
Move

● Vous pouvez effectuer une sélection à l’aide de la touche SELECT.
● Appuyez sur la touche pour passer à l’écran précédent.

1 Appuyez sur la touche TOOL pendant la lecture d’un fichier texte.
● L’écran Text Tool apparaît.

2 Appuyez sur la touche SELECT après avoir ouvert le menu [Bookmark].

3 Appuyez sur la touche SELECT après avoir placé le curseur sur [Add] ou sur [Move].
● Add : un signet est créé dans la page actuelle.
● Move : déplacer le marque-page dans le texte.

I Bookmark

RReemmaarrqquuee
- Vous pouvez créer un signet dans un fichier ou 5 signets dans un répertoire.

✍

Visualiser un texte
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RReemmaarrqquuee
- Les fichiers texte d’une taille supérieure à 500 Ko ne peuvent être lus.

✍

Door.txt
Identity.txt
The Little Prince.txt

TEXT The Little Prince 0011
/0102

Once when I was six
years old I saw a mag-
nificent picture in a
book, called True
Stories from Nature,
about the primeval for

1 Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez Text.
● L’écran Navigation apparaît.

2 Déplacez le curseur sur le fichier texte que vous souhaitez lire, puis appuyez sur
la touche SELECT.
● Le texte sélectionné s'affiche.

- ▲,▼ : permet de régler le volume.
- , : permet d’atteindre la page précédente/suivante.
- Sélection du fichier texte : maintenez la touche SELECT enfoncée pour passer en mode

Navigation pendant la lecture d'un fichier musical. Placez le curseur sur le fichier texte
désiré, puis appuyez sur la touche SELECT.

04 I Text

● Le lecteur de texte vous permet de lire les fichiers texte créés sur votre ordinateur.
Les fichiers texte doivent être en extension .txt pour être lus sur le lecteur de texte.

● Vous pouvez sélectionner un fichier texte à visionner durant la lecture de musique.
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Réglage des principales fonctions du mode Texte
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1 Appuyez sur la touche TOOL pendant la lecture
d’un fichier texte.
● L’écran Text Tool apparaît.

2 Appuyez sur la touche SELECT après avoir placé
le curseur sur [Page Scroll Type].

3 Appuyez sur la touche SELECT après avoir placé
le curseur sur le mode de défilement désiré.
● Line Up/Down : en appuyant sur les touches et , le texte défile ligne par ligne.
● Page Up/Down : en appuyant sur les touches et , le texte défile page par page.

I Page Scroll Type

1 Appuyez sur la touche TOOL pendant la lecture
d’un fichier texte.
● L’écran Text Tool apparaît.

2 Appuyez sur la touche SELECT après avoir placé
le curseur sur [Auto Scroll].

3 Appuyez sur la touche SELECT après avoir placé
le curseur sur la durée de défilement automatique désirée.
● Les options Off, 1, 3, 5 ou 10 secondes sont disponibles.
● La page défile automatiquement lorsque la durée indiquée est écoulée.

I Auto Scroll

Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

Line Up/Down
Page Up/Down

Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

Off
1 sec
3 sec
5 sec
10 sec

Réglage des principales fonctions du mode Texte
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The Little Prince 0011
/0102

Once when I was six
years old I saw a
magnificent picture in
a book, called True
Stories from Nature,
about the primeval for

Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

0 0 1 1 /0102

Toutes les pages

1 Appuyez sur la touche TOOL pendant la lecture d’un fichier texte.
● L’écran Text Tool apparaît.

2 Appuyez sur la touche SELECT après avoir placé le curseur sur [Go to page].

3 Appuyez sur la touche SELECT après avoir sélectionné la page de votre choix.
● permet d’atteindre la page sélectionnée.
● SELECT: permet de sélectionner la page.
● , : permet de déplacer la zone de saisie.

I Go to page

▲ ▲ ▲ ▲

▲▲▲▲
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Visionnage de fichiers vidéo
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05 I Photo/Video
Photo
Video

Photo/Video

Arthur.Svi
SDIARY.Svi
TOM.Svi

VIDEO

1 Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez Photo/Video.
● L’écran Photo/Video apparaît.

2 Appuyez sur la touche SELECT après avoir sélectionné le dossier [Video].

3 Déplacez le curseur sur la vidéo que vous souhaitez visionner, puis appuyez sur
la touche MENU.
● Le fichier vidéo sélectionné est lu.
● ▲ ,▼ : permet de régler le volume.
● (Pression courte sur les touches) , : permet d’atteindre la vidéo précédente/suivante.
● (Pression longue sur les touches) , : recherche rapide
● MENU: permet d’ouvrir l’écran Menu.
● TOOL: permet d’afficher le titre de la vidéo, la durée écoulée et la durée totale.

RReemmaarrqquuee
- Le lecteur ne prend en charge que les fichiers vidéo en extension .svi. Pour visionner des vidéos

en autre format, convertissez les fichiers en utilisant Multimedia Studio et ensuite transférez les fichiers
convertis au lecteur.
Pour transférer un fichier vidéo de format différent, consultez la rubrique “Envoyer des vidéos” dans
“Utilisation de Multimedia Studio”. (Cf. page 34).

✍

Affichage des fichiers image
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05 I Photo/Video
Photo
Video

Photo/Video
HOTELSEA.JPG
SKYSHOW.JPG
flowerpicture.jpg
manillasunset.jpg
sebusunrise.jpg

PHOTO

1 Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez Photo/Video.
● L’écran Photo/Video apparaît.

2 Appuyez sur la touche SELECT après avoir sélectionné le dossier [Photo].

3 Déplacez le curseur sur l’image que vous souhaitez visionner, puis appuyez sur
la touche MENU.
● L'image sélectionnée s'affiche.
● ▲ ,▼ : permet de régler le volume.
● , : permet d’atteindre l’image précédente/suivante.
● MENU: permet d’ouvrir l’écran Menu.
● TOOL: permet d’afficher l’écran Tool (Outils). Sélectionnez [Slide Show] → [On] dans

l’écran Image Tool pour afficher les fichiers image enregistrés sous forme de
diaporama.

RReemmaarrqquuee
- La taille optimale d’image pour ce lecteur est 160x128. Si la taille de l’image est trop grande,

utilisez Multimedia Studio pour ajuster la taille et renvoyez l’image sur le lecteur (Cf. page 32).
- Les fichiers image d’une taille supérieure à 2 Mo ne peuvent être visionnés.

✍
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Utiliser le port USB
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1 Aller au fichier à transférer au lecteur et pressez la touche SELECT. 
● ▲ ,▼ : permet de déplacer le curseur vers le haut ou vers le bas.

● SELECT : permet d’atteindre un sous-dossier ou de sélectionner un fichier.

2 Appuyez sur la touche TOOL pour afficher l’écran USB Tool, puis sélectionnez
[Cut] ou [Copy].
● Cut: si vous collez le fichier sélectionné dans le J70, le fichier d’origine est supprimé.

● Copy: permet de copier le fichier sélectionné.

3 Appuyez sur la touche pour atteindre [YH-J70], puis appuyez sur la touche
SELECT.
● L’écran Navigation du YH-J70 apparaît.

I Transférer des fichiers d’un appareil externe au lecteur.

01-Don’t Know Why.
01-Politik.mp3
01-Solsbury Hill.mp3
iltans Of Swing.mp3
02-Come with Me.mp
02-Hollywood.mp3

Slave Device
01-Don’t Know Why.
01-Politik.mp3
01-Solsbury Hill.mp3
Iltans Of Swing.mp3
02-Come with Me.mp
02-Hollywood.mp3

Slave Device
01-Don’t Know Why.
01-Politik.mp3
01-Solsbury Hill.mp3
Iltans Of Swing.mp3
02-Come with Me.mp
02-Hollywood.mp3

Slave DeviceTOOL

Copy

Cut
Paste
USB disconnect

Suite...

Utiliser le port USB
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Appareil externe USB

Lecteur

Câble USB (appareil externe)

Adaptateur USB

1 Connectez le lecteur à l’adaptateur USB.

2 Utilisez le câble USB de l’appareil externe pour connecter l’appareil
externe à l’adaptateur USB.

3 Appuyez sur la touche MENU pour afficher l’écran Menu.
Sélectionnez USB Host et appuyez sur le bouton SELECT.

4 Utilisez la touche SELECT pour placer le curseur sur 'Please connect a slave
device [OK]' ('Veuillez connecter un périphérique esclave [OK]'), puis appuyez
sur la touche SELECT.
● L'écran Appareil externe apparaît.

I Connexion d’un appareil externe

Please connect a
slave device

05 I USB Host

OK Cancel

COPIED
GAME
MUSIC
PHOTO
PLAYLIST
RECORDED

Slave Device

● Pour pouvoir utiliser la fonction Hôte USB, la capacité du périphérique externe doit être
supérieure ou égale à 128 Mo.

● Le périphérique externe doit posséder un système de fichiers FAT 16/32.
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Utiliser le port USB
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I Hôtes compatibles avec le YH-J70
● Vous pouvez transférer des images de n’importe lequel des appareils photo figurant

dans la liste ci-dessous vers votre YH-J70.
● Vous trouverez ci-dessous la liste des appareils photo compatibles avec la fonction 

Hôte USB du YH-J70.
● Cette liste peut varier en fonction des améliorations.

Fuji Finepix-A340

Fuji Finepix-F450

Fuji Finepix-F810

Panasonic Lumix-FZ20

Olympus 300-Digital

Pentax Optio-S40

H.P. Photosmart 945

NIKON COOLPix 4200

NIKON COOLPix 4300

NIKON COOLPix S1

Panasonic DMC-FX7

YP-55

YP-MT6

YP-T6

YP-ST5

YP-T5

YP-53

YH-920

YP-T7

YH-925

YP-C1

YP-60

YP-T8

Lecteur MP3
(Samsung)

Appareil photo
numérique

ModèleModèleAppareil Appareil

Utiliser le port USB
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4 Sélectionnez le dossier dans lequel le fichier du périphérique externe sera copié.

5 Sélectionnez la touche TOOL pour afficher l’écran USB Tool, puis
sélectionnez [Paste].
● Le fichier sélectionné est transféré vers le lecteur. Ne débranchez pas le lecteur ou le

périphérique externe pendant le transfert de fichier.

RReemmaarrqquuee
- En suivant les procédures décrites ci-dessus, vous pouvez transférer des fichiers du lecteur vers le

périphérique externe.

✍

YH-J70
Slave Device

USB HOST
01-As long as you lov
I’ll be there.mp3
01-Goodbye.mp3
go away.mp3
please.mp3
dreams come true.m

YH-J70

01-As long as you lov
01-love.mp3
01-Goodbye.mp3
go away.mp3
please.mp
dreams come true.m

YH-J70TOOL

Copy
Cut
Paste
USB disconnect
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Jeux
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1 Appuyez sur [START] pour commencer la partie.

[Règles du jeu]
- Lorsque vous placez vos pierres à l’horizontale, à la verticale ou en diagonale,

les pierres situées à l’intérieur entrent en votre possession.
Le côté comportant le plus de pierres à la fin de la partie gagne.

- ▲,▼ ,SELECT: permet de déplacer le curseur vers le haut, vers le bas et d’effectuer une
sélection.

- , : permet de déplacer le curseur vers la gauche ou vers la droite
- TOOL: redémarrer, quitter

I Othello

Nombre de pierres jaunes

Nombre de pierres roses

START

HELP

EXIT

66

Jeux

Niveau actuel

Nombre de pierres
restantes

● Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez Games.
● Mettez le jeu sélectionné en surbrillance, puis appuyez sur la touche SELECT.

1 Appuyez sur [START] pour commencer la partie.

2 Sélectionnez le niveau à l’aide de la touche SELECT lorsque l’écran de
sélection du niveau apparaît.

[Règles du jeu]
- Le but de ce jeu est d’effacer l’écran en inversant les 4 directions de

l’emplacement sélectionné.
Ex; : au niveau 1, si vous sélectionnez la pierre du milieu, les quatre directions

sont inversées et l'écran est effacé.
- ▲,▼ ,SELECT: permet de déplacer le curseur vers le haut, vers le bas et d’effectuer une sélection.
- , : permet de déplacer le curseur vers la gauche ou vers la droite
- TOOL: redémarrer, quitter

I Clear Screen

START

HELP

EXIT

1
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Jeux

F
R

E

1 Appuyez sur [START] pour commencer la partie.

I Tetris

2 Sélectionnez le niveau à l’aide de la touche SELECT lorsque l’écran de
sélection du niveau apparaît.

[Règles du jeu]
- Le but de ce jeu est d'éliminer les lignes en empilant des briques de formes

différentes.
- SELECT : modifier la forme des briques
- , : permet de déplacer le curseur vers la gauche ou vers la droite
- ▼ : permet de faire descendre les briques rapidement vers le bas.
- TOOL: redémarrer, quitter

Niveau

Nombre de lignes à effacer avant de
passer au niveau suivant.

Score

START

HELP

EXIT

LINES :    30
SCORE :    0

Jeux
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1 Appuyez sur [START] pour commencer la partie.

[Règles du jeu]
- Le côté comportant 5 pierres droites sur des lignes horizontales, verticales ou

diagonales remporte la partie.
- ▲,▼ ,SELECT: permet de déplacer le curseur vers le haut, vers le bas et d’effectuer une

sélection.
- , : permet de déplacer le curseur vers la gauche ou vers la droite
- TOOL: redémarrer, quitter

I Omok
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Fonctions avancées
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1 Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez Settings.

2 Dans Settings, allez à la fonction que vous désirez et pressez la touche SELECT.
● Pressez la touche pour aller au menu précèdent.

Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings

Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings

Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings
Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings
Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings

Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings

08 I Settings

Jeux
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Playing Games

1 Appuyez sur [START] pour commencer la partie.

I Chips

2 Sélectionnez le niveau à l’aide de la touche SELECT lorsque l’écran de
sélection du niveau apparaît.

[Règles du jeu]
- Le but de ce jeu est d’atteindre la porte finale en déplaçant des obstacles et en

obtenant des clés et des objets. Vous ne pouvez franchir la porte que si vous
détenez la clé et  vous ne pouvez passer au niveau suivant qu’après avoir ramassé
le nombre d’objets requis pour chaque niveau.

- ▲,▼ : permet de déplacer le curseur vers le haut, vers le bas et d’effectuer une sélection.
- , : permet de déplacer le curseur vers la gauche ou vers la droite
- TOOL: redémarrer, quitter

Niveau
actuel

X

START

HELP

EXIT

Le nombre d’objets qu’il vous reste à ramasser
avant de passer au niveau suivant.
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Réglage de l’affichage
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● Utilisez la touche SELECT pour régler la durée avant
l’extinction de l’écran LCD.

● La durée avant extinction de l’écran LCD peut être réglée
sur 10 secondes, 20 secondes, 30 secondes ou Always On.

● Lorsqu'il est réglé sur Always On, le rétro éclairage
fonctionne en permanence.

● L’écran s’éteint une fois cette durée écoulée.
L’écran se rallume si une touche est enfoncée.

I Lcd Off Time

10 sec
20 sec
30 sec
Always On

Lcd Off Time

1 Sélectionnez la couleur de votre choix pour le texte.
● , : permet de déplacer le curseur vers la gauche

ou vers la droite

● ▲ ,▼, SELECT: Sélectionner

2 Une fois l’heure réglée, allez sur OK, puis appuyez
sur la touche SELECT.
● Si vous sélectionnez une couleur, le texte s’affiche dans

cette couleur.

I Text Set

OK Cancel

Color

Text Set

Réglage de l’affichage
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● Utilisez la touche SELECT pour régler la vitesse de
défilement et ainsi ajuster la vitesse de déplacement du
titre de la piste.

● La vitesse de défilement peut être réglée sur 0.5x, 1x, 1.5x
ou 2x.

I Scroll Speed

● Utilisez la touche SELECT pour régler la durée de rétro
éclairage.

● La durée de rétro éclairage peut être réglée sur Off,
3 secondes, 5 secondes, 10 secondes ou Always On.

● Lorsqu'il est réglé sur Always On, le rétro éclairage fonc-
tionne en permanence.

I Backlight

Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] → [Display].

0.5x
1x
1.5x
2x

Scroll Speed

Off
3 sec
5 sec
10 sec
Always On

Backlight
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Réglage des effets sonores
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● Utilisez la touche SELECT pour sélectionner Automatic EQ On/Off.
● On : L’égaliseur est automatiquement sélectionné parmi les valeurs Jazz, Classic, Pop ou

Rock en fonction des informations contenues dans l'étiquette ID3 du fichier musical.
● Off : le fichier musical est lu dans le mode EQ choisi.

I Auto EQ

- Protégez vos oreilles en augmentant le son
progressivement lorsque la lecture commence.

● Utilisez la touche SELECT pour sélectionner la durée de
fondu désirée.
- Off : la musique est lue selon le volume sonore sélectionné.
- 3 sec : le volume sonore de la musique augmente

progressivement pendant 3 secondes.
- 5 sec : le volume sonore de la musique augmente

progressivement pendant 5 secondes.

I Fade In

MODE EQ INFOS DE L'ETIQUETTE

CLASSIC ROCK, CHRISTIAN ROCK, ROCK,
ALTERNROCK, INSTRUMENTAL ROCK,

ROCK
SOUTHERN ROCK, ROCK & ROLL, HARD ROCK,
FOLK-ROCK, GOTHIC ROCK, PROGRESSIVE ROCK,
PSYCHEDELIC ROCK, SYMPHONIC ROCK,
SLOW ROCK, PUNK ROCK, DEATH METAL

CLASSIC
CLASSIC, OPERA, CHAMBER MUSIC
SONATA, SYMPHONY

JAZZ JAZZ, JAZZ+FUNK, ACID JAZZ

POP
POP, INSTRUMENTAL POP, POP-FOLK, DANCE
EURODANCE, DANCEHALL, DISCO, HIP-HOP

On
Off

Auto EQ

Off
3 sec
5 sec

Fade In
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Réglage des effets sonores

1 Sélectionnez le niveau de WOW désiré.
● Le contrôle du niveau WOW ne s’applique que lorsque

SRS, TruBass ou WOW est sélectionné. Vous pouvez
régler SRS et TruBass sur une valeur comprise entre
0 et 10 et Definition sur une valeur comprise
entre 0 et 8 et Limiter sur une valeur comprise entre 0 et 10.

● SELECT : permet de déplacer le curseur vers le haut,
vers le bas et d’effectuer une sélection.

● , : permet de modifier le niveau.
● SRS : le lecteur bascule en son stéréo 3D.
● TruBass : fonction d'amplification des basses qui ajoute de l'amplitude au son.
● Definition: permet de restaurer la perte de son d’un original et fournit une meilleure

qualité de son.
● Limiter: permet de réduire la déformation du son pendant la lecture d’un fichier musical.

2 Une fois l’heure réglée, allez sur OK, puis appuyez sur la touche SELECT.

- Cette fonction permet d’optimiser la fonction SRS
selon l’appareil connecté.

● Utilisez le bouton SELECT pour sélectionner le périphérique
connecté.

● Earphone → Headphone → Speaker → Carpack

I WOW Level

I WOW Optimum

Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] → [Sound Effect].

Earphone
Headphone
Speaker
Carpack

WOW Optimum

OK Cancel

SRS
TruBass
Definition
Limiter

5
5
1
1

WOW Level
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Réglage de l’heure/du calendrier

F
R

E

1 Sélectionnez [New Memo] lorsque l’écran Memo apparaît.

2 Tapez le contenu désiré.
● Procédure de saisie

Déplacez le curseur sur la touche de votre choix
à l’aide des touches ▲,▼, et puis
appuyez sur la touche SELECT.
Appuyez deux fois sur la touche SELECT pour
saisir la seconde lettre correspondant à la touche.

Ex. : pour saisir “MOVE”,
Mettez le curseur sur la touche sélectionnée,
puis appuyez sur la touche SELECT.

(Once) → (3 times) → (3 times) → (2 times)

● Sélectionnez pour supprimer une lettre et pour insérer un espace.

I Memo

Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] →
[Time/Schedule].

Memo

OK Cancel

RReemmaarrqquuee
- Un mémo ne peut pas faire plus d’une page.

✍

Suite...

Réglage des effets sonores
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- Si User EQ est sélectionné dans EQ, l’égaliseur
peut être réglé selon les préférences que vous
avez indiquées dans User EQ Set.

● Utilisez les touches et pour déplacer le curseur
vers la gauche ou vers la droite et utilisez la touche
SELECT pour régler le volume.
Une fois l’heure réglée, allez sur OK, puis appuyez sur la
touche SELECT.

I User EQ Set

● Appuyez sur la touche SELECT pour sélectionner Clicker
On/Off.

● On : vous pouvez entendre un clic à chaque fois qu'une
touche est enfoncée.

● Off : aucun son n'est émis lorsqu'une touche est enfoncée.

I Clicker

On
Off

Clicker

OK Cancel

User EQ Set

60     250    1K     4K     16K
125    500    2K     8K

+10dB

0dB

-10dB
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Réglage de l’heure/du calendrier
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PM

Folder

NORMAL

MP3

NOR05:38

192kbps √ 003/007

35

JOY.mp3

OO:00:40

1 Utilisez les touches et pour régler l'heure de
la minuterie sommeil.
● Le temps de sommeil peut être règlé sur : off et de 10 à

120 minutes. Le lecteur s’éteindra automatiquement après
la durée réglée.

● Quand le temps de sommeil est réglé sur Off, la fonction
est désactivée.

2 Une fois l’heure réglée, allez sur OK, puis appuyez
sur la touche SELECT.

I Sleep

● Vous pouvez régler l’heure et la date.

1 Utilisez la touche SELECT pour atteindre l’étape suivante, puis sélectionnez l’an-
née, le mois et la date à l’aide de la touche , .

2 Appuyez sur la touche après avoir placé le curseur sur Time.
3 Utilisez les touches et pour régler l’heure actuelle, puis appuyez sur la

touche SELECT.
4 Une fois l’heure réglée, allez sur OK, puis appuyez sur la touche SELECT.

I Date/Time

Sleep Time

OK Cancel

30 Min

Date/Time
2005

07 FRI
1 (JAN)

01:17 AM

OK Cancel

Year

Day
Month

Time

▼

▼

▼

▼

▼

▼
▼

Réglage de l’heure/du calendrier
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1 Appuyez sur la touche TOOL dans la fenêtre
Calendrier.
● Day: permet de faire défiler les jours un à un.
● Month: permet de faire défiler les mois un à un.
● Year: permet de faire défiler les années une à une.

2 Placez le curseur sur la date que vous souhaitez
sélectionner.
● ▲,▼ : permet de déplacer le curseur vers le haut ou vers le bas.
● , : permet de déplacer le curseur vers la gauche ou vers la droite

3 Appuyez sur la touche SELECT après avoir vérifié les informations.
● L’écran précédent s’affiche.

3 Appuyez sur la touche TOOL.
● Keypad Set : Vous pouvez modifier le clavier. 

Vous pouvez sélectionner Korean → Numeric  → Capital
English Font → Small English Font → Special
Characters (Coréen → Numérique →Anglais majuscules
→Anglais minuscules → Caractères spéciaux)

● Clear : permet de supprimer le mémo.

4 Une fois la saisie terminée, allez sur OK, puis
appuyez sur la touche SELECT.

»≠∏È ¡̂ øÚ

OK Cancel

Keypad Set 
Clear

Tool

123
ABC
abc
!~^

Calendar
42005

3
10
17
24

4
11
18
25

5
12
19
26

6
13
20
27

7
14
21
28

1
8
15
22
29

2
9
16
23
30

I Calendar

▲
▼

▲
▼

RReemmaarrqquuee
- Placez le curseur sur un mémo à supprimer dans l'écran Select Mémo, puis appuyez sur la

touche TOOL. Puis, sélectionnez [Delete] pour supprimer le mémo.

✍
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Paramêtres d’enregistrement.
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Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] → [Record].

● Utilisez la touche SELECT pour sélectionner le débit
binaire d’enregistrement désiré.

● Le débit binaire d’enregistrement peut être réglé sur
40 kbits/s, 64 kbits/s, 96 kbits/s, 128 kbits/s ou
192 kbits/s.

I Bit Rate

● Utilisez la touche SELECT pour régler l’heure de
synchronisation automatique (Auto Sync Time).

● La fonction Temps de synchronisation automatique
sert a séparer et sauver les fichiers MP3 quand il
n’y a pas de son durant un enregistrement MP3.

● En Sync 1, l’enregistrement s’arrête et se met en
mode musical quand il n’y a pas de son pendant
plus de 2 secondes durant l’enregistrement.

● Quand la synchronisation automatique est réglée sur
Off, l’enregistrement continue même lorsqu’il n’y a pas
de son et est ensuite enregistré dans un seul fichier.

I Auto Sync

40 kbps
64 kbps
96 kbps
128 kbps
192 kbps

Bit Rate

Off
Sync1
On

Auto Sync
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Réglage de la radio FM

Korea/US
Other Country

FM Region

Low
Mid
High

FM Search Level

● Utilisez la touche SELECT pour sélectionner la
région de réception FM désirée.
- Korea/U.S : Rechercher des stations FM entre

"87,5" MHz et "108,0" MHz par
échelons de 100 kHz.

- Other Country : Rechercher des stations FM entre
"87,5" MHz et "108,0" MHz par
échelons de 50 kHz.

I FM Region

● Utilisez la touche SELECT pour sélectionner le
niveau de recherche FM désiré.
- Plus le niveau de recherche FM est élevé, plus

votre lecteur peut recevoir de fréquences.
- Low → Mid → High

I FM Search Level

Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] → [FM Radio].

RReemmaarrqquuee
- La région FM par défaut varie en fonction de la zone d’achat du lecteur.

✍
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● Utilisez la touche SELECT pour sélectionner la
vitesse de lecture désirée.

● La vitesse de lecture peut varier entre x0.8, x1, x1.2,
x1.4 ou x1.6.

● Plus le chiffre est élevé, moindre est la vitesse de
lecture et plus le chiffre est petit, plus lente est la
vitesse de lecture.

I Play Speed

● Utilisez la touche SELECT pour sélectionner
Resume On/Off.

● On : La lecture reprend au point où elle s’est arrêtée.
En cas de fichiers texte, le texte reprendra à
l’endroit du fichier où se trouvait le curseur la
dernière fois qu’il a été ouvert.

● Off : la lecture reprend à partir du début du fichier/de
la piste qui était lu(e) au moment de l'arrêt. En cas de
fichiers texte, le texte reprendra au début du fichier.

I Resume

0.8x
1x
1.2x
1.4x
1.6x

Play Speed

On
Off

Resume

Removable Disk
Charge

PC Connect Mode
● Utilisez la touche SELECT pour sélectionner le mode

de connexion au PC.
● Removable Disk: permet d’enregistrer des fichiers

sur un disque amovible ou de transférer des fichiers
image ou vidéo à l’aide de Multimedia Studio.

● Charge: permet de recharger le lecteur à l’aide du
câble USB.

I PC Connect Mode
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Paramètres Système

English
Korean
Japanese
Simplified Chinese
Traditional Chinese
Russian

File Language

Languages

Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] → [System].

● Utilisez la touche SELECT pour sélectionner la
langue d’affichage désirée pour les écrans de menu.

●

I Languages

● Utilisez la touche SELECT pour sélectionner la langue
d’affichage désirée pour les étiquettes et le texte.

● English → Korean → Japanese → Simplified Chinese →
Traditional Chinese → Russian → Spanish → French →
German → Italian → Albanian → Afrikaans → Basque →
Bulgarian → Byelorussian → Catalan → Czech → Croatian →
Danish → Dutch → Estonian → Faeroese → Finnish →

Galician → Hungarian → Icelandic → Irish → Latvian →
Lithuanian → Macedonian → Norwegian → Polish →
Porthguuese → Rhaeto-Romanic → Romanian →
Scottish → Serbian → Singaporean → Slovak → Slovenian →
Swahili → Swedish → Ukrainian

I File Language

RReemmaarrqquuee
- Qu'est-ce qu'une balise ID3?

Il s'agit d'une balise jointe à un fichier MP3 qui contient les informations pertinentes relatives
au fichier : titre, artiste, album, année, genre et un champ commentaires.

- Les langues prises en charges peuvent être modifiées ou ajoutées.

✍
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MENU Table

‚ · ” ¨ › ‚ ØMENU

MUSIC FM Radio Navigation Text Photo/Video USB Host Games Settings

Clear Screen

Othello

Omok

Tetris

Chips

Scroll Speed

Backlight

Lcd Off Time

Text Set

WOW Level

WOW Optimum

Memo

Calendar

FM Region

FM Search Level

Bit Rate

Auto Sync

Languages

File Language

Play Speed

Resume

PC Connect Mode

Defualt Set

About

Auto EQ

Fade In

Sleep

Date/Time

User EQ Set

Clicker

Display Sound Effect Time/Schedule FM Radio Record System

● Utilisez la touche “SELECT” pour valider le menu désiré.
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Paramètres Système

Volume = 40

Répétition = OFF

Paramétrage des effects sonors = OFF

Contraste = 3 secondes

Paramètres initiaux

No
Yes

Default Set

● Utilisez la touche SELECT pour sélectionner Yes ou No en ce qui concerne les
réglages par défaut.

● Si vous sélectionnez [Yes], une fenêtre pop-up apparaît. Si vous sélectionnez [OK],
tous les paramètres sélectionnés retrouveront leurs réglages par défaut.

I Default Set

● Sélectionnez About (A propos de) pour vérifier la capacité totale, la capacité
disponible et la version du logiciel.

I About
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Dépannage

La durée de lecture affichée pendant la lecture semble erronée.
● Vérifiez si votre fichier est un fichier VBR (variable bit rate) Les fichiers VBR ne sont pris en charge

que partiellement.

Les touches du lecteur ne fonctionnent pas.
● Assurez-vous que le bouton Hold est en position Off.
● Vérifiez si le câble USB est branché.

Les touches ne fonctionnent pas lorsque le câble USB est branché.

L’écran ACL est trop sombre.
● Vérifiez la durée de rétroéclairage/ la durée avant extinction de l’écran LCD.

Pendant la lecture, certains caractères inconnus s’affichent sur l’écran.
● Les langues non prises en charge sont signalées par un point d’interrogation (?).

"Null" apparaît sur l’écran de lecture à la place du titre du fichier musical
sélectionné.
● Il n’y a aucune information sur l’étiquette ID3 du fichier musical. Éditez le titre de la chanson,

l’artiste, l’album et les informations relatives à la chanson.

La recherche de chansons par Titre, Artiste ou Album demande beaucoup de temps.
● Si votre lecteur contient de nombreux fichiers musicaux, la recherche peut prendre un 

certain temps.
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Dépannage

La recherche de fichiers à partir du menu Navigation ne fonctionne pas correctement.
● Après avoir connecté le lecteur au PC, lancez Media Studio, puis sélectionnez

[Device] → [Reconstruct Library].

Le lecteur ne fonctionne pas. Rien n’apparaît sur l’écran.
● Réinitialisez le lecteur.
● Connectez le chargeur.
● Assurez-vous que le bouton Hold est en position Off.

Il n’y a aucun son même si j’appuie sur la touche Lecture en mode Musique.
● Vérifiez que le lecteur contient bien des fichiers MP3 ou WMA.
● Les formats de fichiers non pris en charge (fichiers MPEG1 COUCHE 1 par exemple) ne

peuvent être lus.

Je ne parviens pas à télécharger des fichiers.
● Vérifiez le niveau de charge de la batterie.
● Vérifiez que le pilote est correctement installé sur votre PC.

Le lecteur sera déconnecté si vous redémarrez le PC pendant que le lecteur est connecté
à ce dernier. Essayez de reconnecter le lecteur.

● Vérifiez si l’icône “Débrancher/éjecter” ou “Retirer le préiphériaue en toute sécurité” se trouve
dans la barre des tâches située en bas de votre écran.

Le rétroéclairage est éteint.
● Veuillez vérifier les réglages du rétroéclairage.
● Le rétroéclairage est automatiquement désactivé afin de prolonger la durée de lecture si la

batterie devient trop faible.
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Spécifications

L’unité qui se trouve avec ce manuel de l’utilisateur est fournie sous licence sous 
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée à une
utilisation privée non commerciale par l’utilisateur final pour les contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue à un
produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-3 ou
ISO/IEC 13818-3 utilisé ou vendu avec ce produit. 
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou décoder 
des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des fonctions 
du produit qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

Modèle YH-J70
Capacité de mémoire interne YH-J70 SB/SW(20Go) / YH-J70 LB/LW(30Go) 

Capacité de la batterie rechargeable incorporée 950mAh
Tension 4.2V (batterie Li-ion rechargeable)

Dimensions/Poids 62 X 99.8 X 16.4mm/135g
Boîtier Plastique

Rapport Signal/Bruit 90 dB avec 20 KHz LPF (sur la base de 1KHz 0 dB)
Puissance de la prise de sortie Écouteurs 20mW (France 5mW/CH) (16 Ω)

Plage de fréquence de sortie 20Hz~20KHz
Plage de température de fonctionnement -5~ +35°C (23~95°F)

Fréquence FM 87.50 ~ 108.00MHz
Rapport signal FM sur bruit 45dB

T.H.D. FM 1%
Sensibilité FM utile 10dB

AUDIO : MPEG1/2/2.5 Layer3(8Kbps~320Kbps, 8KHz~48KHz), WMA,
Audio ASF (48Kbps~192Kbps, 8KHz~48KHz), Ogg (Q0~Q10)

IMAGE : QCIF 160x128

Nombre de fichiers lisibles Dossier normal : 1024 Files
Dossier enregistré : 999 Files

Fichiers pris en charge
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Spécifications

Ce symbole sur le produit ou sa documentation indique qu’il ne doit pas être
éliminé en fin de vie avec les autres déchets ménagers. L’élimination
incontrôlée des déchets pouvant porter préjudice à l’environnement ou à la
santé humaine, veuillez le séparer des autres types de déchets et le recycler
de façon responsable. 
Vous favoriserez ainsi la réutilisation durable des ressources matérielles.
Les particuliers sont invités à contacter le distributeur leur ayant vendu le
produit ou à se renseigner auprès de leur mairie pour savoir où et comment ils
peuvent se débarrasser de ce produit afin qu’il soit recyclé en respectant
l’environnement.
Les entreprises sont invitées à contacter leurs fournisseurs et à consulter les 
conditions de leur contrat de vente. Ce produit ne doit pas être éliminé avec les
autres déchets commerciaux.


